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Introduction

SmartDesign® is the program which focuses on designing a card so you can print card
data one by one. However when the data is huge, it takes too much time to print every data
one by one.

For this reason, SmartDB® is developed and you can print several data at once using this
program. This program is able to be linked with DBMS via ODBC function and have many

useful functions such as “Multi-language Support” and “Print History”.

1.1 System Requirements
SmartDB can be operated with only IDP Corp,.Ltd’s SMART card printers.
The required software and hardware configuration for your computer system to execute
SmartDB is as below.
- Windows XP, Vista, 7
- Pentium 1G Hz
- 256MB RAM

1.2 Program Structure

If you design a card in SmartDesign and save in your PC, the file will be saved as
“*.CSD”. In this CSD file, there is “Field” section and it is for linking texts, images and
barcodes to SmartDB so that SmartDB program can modify the items.

You don’t need to change data case by case in SmartDesign but you can modify
different data using SmartDB at once. If you edit CSD “Field” in SmartDB, it will be the
same effect as you modified the CSD file. But this changed data is valid until closing
CSD file in SmartDB. So if you close CSD file or exit SmartDB program, the original
design of CSD data would not be changed.

You can design and modify large numbers of cards through SmartDB quickly and safely.
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2 Program Start

Usage of this program will be introduced in this chapter briefly.

2.1 Execute Program
From Window’s Start menu
Click Start Menu > All Programs > Smart > SmartDB

From the shortcut icon created on Desktop background
Double-click the icon which is created on Desktop background after installation of

program.

When you run the program, it will be displayed as Fig. 2.

s Smart DB o B3

=
@
@ CSD Fields T&IA
®
Figure 2 SmartDB Window
(@ Ribbon bar
Please refer to chapter 4.Ribbon bar
@ Filter bar
Please refer to chapter 3.11 Use the Conditional Formula
® Data



It shows data which is connected to CSD field and DB field.

@ Preview
It shows preview image. If a document has single side, it shows only front side. If a
document has both sides, it shows another tap for the back of the document.
When select the tap, it will present preview image of back side.

& CSD fields / DB fields
When you select a CSD field tap, it shows field information of the CSD file opened.

When you select DB field tap, it shows recorded information of Database.

2.2 Create New Project
To connect a CSD file and Database, create new project.

(O Create a CSD file which has fields section using SmartDesign.

For more information, please refer to user manual of SmartDesign.

(@ Click File tab and New button, or Click |/ New button on home tab.

[, New Project £2
¥l Auto Create Database

Peoject Mame |Mew Project

CSD File D
(]

Project Location |GiProgram Files p@RUDFSmartc SR

[ o ] [ canca |

Figure 3 New Project

@ Click upper “...” button and open the saved CSD file. When you select a CSD file,
Project Name will be changed as the CSD file name.

@ Click lower "..." button and select the path where the new project is saved in.

(® “Auto Create Database” is the function which creates and connects database
automatically according to CSD fields when you make new project.
Select CSD file and mark Auto Create Database Check box. Click OK.
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[+, Connect Fields £3

Match C50D and DE Fields

C3D Fields DB Fields DB Fields

MAME
—
EHOTONMM F 070
4 FOS
A EMART_FRTMARK  FPRTMARK
6 |SMART_PRTIMFO F'R"

7 |PHOTO_CONFIG FH

1

2
3

SO A

Do vou want bo connect fields?

-

’ < Back[B) ” Confirm ] ’ Cancel ]

Figure 4 Connect Fields

® Above image shows how CSD fields and Database(DB) are connected. Database
is created and connected automatically according to CSD fields because “Auto
Create Database” is activated.
In “CSD Fields” column, the blue color section is “Field Name” of the CSD file. Pink
color section is print record fields, and these sections are used in SmartDB. Yellow
color section is Image field. In case there are connected CSD field images, it will
be created automatically.
When “Do you want to connect fields?” window appears, select Yes to connect
CSD fields with DB fields.

After CSD fields are connected to DB fields, the program will be changed as Fig. 5.

11



Fitter

Home

Datzbase

g

Open

Project

v

save

Options
Print.

Print

Help

e @ g v

Printed  Unprinted Al

v

Mark

v

Smart DB

Printed  Unprinted
Cords  Cards

Display

Cards

%8 &

Printed  Unprinted  Text

Search
Add

&
iz I =
¥ wEdt
Positon | Edit
5 Delete
card Design

Front Side

Apply

PHOTG | oS |
PHOTO os |

NAME I [ |
nave | D |

=
o8 |

CSD Fields DB Fields

~

Read/Write |  C:\Program Files (x88)\DP\Smart\CSP\sample 1\sample L.mdb ~ TABLE Ready Total Records : 0

Figure 5 After DB connection

CSD preview will be shown on the right side and CSD fields and DB fields will be
displayed.

From now on, you can input and edit data.

SmartDB manages projects as the unit of directories. So a directory is created as
“Project Name” on appointed “Project Location” and all files will be copied in the

folder.

2.3 Input Data
To input data, click Add in Home tab or Database tab.

Input data in Value column.

Select an image after click “...” button when you use image field. To delete or change
an image, right-click Value column. When you select Select Image in context menu,
you can select new image. And also you can delete an image using Remove Image in

context menu.
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[, Add Card 23
Mame Type Value [<]
; g:::g Capture
3 PHOTO Image [ Canét;:':!lgin
FOS String

Print & Continue

Save & Continue

Save & Close

Clear

dlaHile

= Close

Figure 6 Add Data

If you click Image Field when USB Camera is connected to PC, Capture button will be
activated on the right side. Click activated Capture button, and then camera view
window appears like Fig. 7.

Click Capture button in the window, then program will save the image as Fig. 8.

e -, Add Card £

L Name Type Value =
1 NAME String  John Doe
2.0 Sting 02110
oo TN D e
Do | e

-= Print & Cont
s,

af

Figure 7 Capture Figure 8 Add Figure Image

If Plugin is installed in SmartDB program folder, the buttons will be displayed as plugin
names like figure 9. Click a button and execute plugin so that you can import an image.

Please refer to Appendix — Plugin part.

€2, Add Card =

Name | Type Value ]
1 [NAME Sting
2 D Sting

e - :]

4 POS Sting

5
6
7 Print & Continue

o [ ]
Figure 9 Plugin Data Added
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To print the data in Add Card window, Click Print & Continue button.

Dialog B

18A SMART Card Printer [KYLE : USB001] -

LIS
104910

{

Issue i Cancel

Figure 10 Print & Continue
Select a printer on upper combo box and click Issue button to print. After printing
process, preview window will be closed automatically and the data of printed content

will be added in Database automatically.

#l= Smart DB = B R
O e Datmbese Optos  er (2]
-~ = = a a £
” el B =3 =3 - [ [ 2 Add ﬁ
7 Q @ &2 | ¥ 3> 2ol
New Open Save Print Printed  Unprinted All Printed  Unprinted Printed  Unprinted Text Position . Edit
Cords | Cards Cards W Delete
Project. Print Mark: Display Search Card Design
rier | v vl v | A [ Front Side
[ | ey =
=] e [ © [ mew | s ] B wer,
oo | ne | o | woo | ms
[:. Add Card b
Name Type Value =
1 | MAME String  Joe
2 D String 106301
,
} 3 |PHOTO Image '3
4 |POS String | Senior Engineer
5 PRIMARK  Sting | RAWE -
|| B PRTNFO  LString ] John Doe
7 PHOTOCON. Sting | 0
1201202
Save & Close. ‘5
POS
Sales Manager
B Close a
-
| ¥

Figure 11 Add Data

To save data and keep the current window, click Save & Close button.
To save data and close the current window, click Save & Continue button.
To clear whole data in current window, click Clear button.

To close the window without save, click Close button.
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@l Smart DB e
B o | oo ot b 2]

= 4 A [ = @ @ @ 8 hdd ~ ]

] T B o @ g & v e % & & o =2

New  Open  swe et Pt Upmed | AL poved Umeted | Ped Upned Tt Poston | st

Cards Cards Cards ) Delete:
print Dsploy o
|

Readirite| _C:\Program s (x86)VDP\SmartiCSPlsample isamplemdb _ TABLE Ready TotalRecords: 5

Figure 12 After Adding Data

If you add a card, the new data is updated on the screen as Figure 12.

Selected data is updated through data field and it is displayed in preview section.

2.4 Edit Data

There are two ways to edit data user entered.

Click Edit in Home tab or Database tab. Then it will be displayed as Fig. 13.

[, Update Card =
Name Type Value [a]
1 [NAME String  John Doe
2 b String 1201202
-
3 PHOTO Image 21
4 POS String  Sales Manager
P T
b PO Lsmg -
7 PHOTOLCON Sty -
B
oo
o [ o ]

Figure 13 Editing Data

Double-click the column to edit. Then input data directly to the column as Fig. 14.
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Smart DB = 5

Fome  botbese  optons Help )
- r=ul - q a
R Y
e : e A
g L & | ¥ > ) e \
pen  Sme | Pt | proed Upemed || AL | Pied Umprnied | ined Umpiied  Tox  Fositon wa
Cards | Cords  Cards % Delete
poect ot erk Oeplay searh o | veson
3 3 3 = on Side
Fiter R
Apply.
= e 5] -
o e | o | =
i e o S Honager
lJoe 5
Toe301
2 e SerorEniner
5 e s —
o Fiolds | vorew |
i =
o n s RS—— o0
- o
106301
5 Loy sanian — 0T
Tl
o5
Seior Enginser
readinie] db_TABLE Ready TotolRecads 5

Figure 14 Direct Input in Column

2.5 Print
Connect a card printer to PC before printing.

@ To print, select the data as Fig.15 and click Print button in Home tab or File tab.

Smart 0B C o=
o o e o
- r=ul - ‘z
" e als|lvy & 2 add
L1 7 g L & | ¥ = = e A
New e Swe | Pt | pmed pmed | Al | Ped Upmed | mined Uped  Ted  Feston wa
Cards | Cords  Cards % Delete
poect ot erk Oeplay searh o | veson
3 3 3 = on Side
Fiter R
Apply.
P TS O =
o] wm | o | e || ms

1201202

CSD Fields DB Fields

NANE -

4 | 235915 7 Prostuct Manager [John Doe

D
1201202
PHOTO

5 |oy 630140

Manager

Fos
Sales Manager

Readwite| db TABLE Ready TotalRecords : 5

Figure 15 Select Data for Printing

I%, Select Printer 2
Printer
IDP SMART-30 Card Printer [IKYLE : USBO01] v
Mumber of cards 3
Confirrn Cancel

Figure 16 Select Printer
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(@ Figure 16 shows available printer which is connected PC or network

The printers which have a word “USB” on the lists are connected to PC directly.

The printers which names start with IP address are connected to network.

Choose a printer and click Confirm button.

@h IDP SMART-50 Card Printer [KYLE : USBOO1]

HAME
1 John Do
2 Joe
3 Kyle

Ready

Print

Remove printed cards

D
1201202
106301
01215

FHOTO POS
C:\Program Files (xBB)UIDP! Sales Manager
C:\Program Files (xB6)IDP! Senior Enginesr
C:\Program Files (xE6)|IDP Engineer

Reset failed cards

[»]

[«]

Close

Printed: 0/3

Figure 17 Print Spooler

(® Figure 17 shows printer spooler window.

Click Print button, then all data on the lists will be printed.

gh IDP SMART-50 Card Printsr [KYLE : USBOO01]

 Use Printer spool

HAME
1 John Doe

2 Joe

3 Kyle

4]

Printing

(o)
1201202
106301
01215

FHOTO FOS
Ci\Program Files (x86)\IDP! Sales Manager
CtiProgram Files (xB6)\IDF| Senior Enginesr
CtiProgram Files (xB6)\IDFI Enginser

[»]

[4]

[»

Stop Close

Frinted: 0] 3

Figure 18 Printing

The white background means the data which is ready to print. The green color

means under printing. After finish the printing, the color will be changed to yellow. If

there is an error during the printing, it will be changed to red color. Even though it

is under printing, you can add more data to print.

@ When printing is done, click Close to return to main program.

Printing results will be applied to data list as Fig. 19.
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N Smart DB o B o2

o )
= — = o @
- A 4 = @ @ @ o
D 8 ¢ @ & & % & % & & B
New Open Save Print. Printed  Unprinted All Printed  Unprinted Printed  Unprinted Text Position Edit
Cards | Cards Cards 53 Delete
et = o b - 2| ==
S 3 3 o
e
Apply.
= m= [ b | moe [ @
D w= [ o | wme [ &
-,
1 |somDos 1201202 Gl seles vencw
-, 630140
. - [ —
»,
3 |k 01215 W croneer
[ coofows [ orew |
-, [MAME )
4+ m 28315 Sl Product Manager [Joy
| I— =3
- cannao
5 |wy 0140 f eneoer RO

Pos
Manager

Readjrite | C:\Program Fies (+86)JDP\smart|CSPlsample sample.mdb_ TABLE Ready Total Records : 5

Figure 19 After Printing

3 Main Function

The main function will be explained in this chapter.

3.1 Create New Project
To connect a CSD file and Database, create new project.

Create a CSD file which has fields section using SmartDesign.

For more information, please refer to user manual of SmartDesign.

@ Click File tab and New button, or Click ! New button on home tab.

( [%. New Project £3
M Auto Create Database
Peojact Name |New Froject
CSD File E]
Project Location |CiProgram Files (S6NDPSmMatCSPL E]

ok ) [ oo ]

Figure 20 New Project
Click upper “...” button and open the saved CSD file. When you select a CSD file,

Project Name will be changed as the CSD file name.

@) Click lower "..." button and select the path where the new project is saved in.
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@ “Auto Create Database” is the function which creates and connects database
automatically according to CSD fields when you make new project.
If it is connected with the existing database, you have to remove the mark in this
section.

@ Project file will be generated as *.csp in the folder under the directory which set on

“Project Location”.

3.2 Create / Modify Database
3.2.1 Auto Create Database
If “Auto Create Database” option is activated in chapter 3.1, MDB database will

be created and connected automatically as CSD file’s fields.

In “CSD Fields” column, the blue color section is field name of the CSD file.
Pink color section is the print record field, and these are used in SmartDB.
Yellow color section is Image field. If there is connected image in SmartDB, it

will add “_CONFIG” in the last part of the field name and will be created.

[7. Connect Fields £2

Match CSD and DE Fields

CSD Fields DB Fields DB 2lds

1 [ETENS | M E

, I -

3 EHOTOMMN FH0TO

+ EOSMM -0

5 SMART_PRTMARK PRTMARK
5 SMART_PRTIMNFO FR

7 |PHOTO_COMFIG PH

L LK SIS

Do you want to connect fields?

-

’(Back@] ” Confirmn ] ’ Cancel ]

Figure 21 Connect Fields

If “Do you want to connect field?” box appears, click Yes to connect

CSD field name and DB field name automatically.

3.2.2 Manual Create Database

If “Auto Create Database” option is not activated at chapter 3.1, it needs to
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create database manually or connect to current ODBC.
Click Database tab and Connect MDB button. Then “MDB Management’

window will be displayed as Fig. 22.

[:. MDB Management

MOB Table Management

Mew Table

Edit Table

Remove Table

Connect Fields

Refresh

Figure 22 MDB Management

3.2.2.1 Auto Create MDB
@ Click Automatic Create MDB button, then “Automatic Create MDB” windows
as Fig. 23 will be displayed.

[, Automatic Create MDE

MDB MName | 001

Table Name | 00|

1
2
3
4
5
&}
7

Fieldhiame

S

[n]

FHOTO

FOS

PRTIMARK
PRTINFC
PHOTO_CONFIG

Type
String
String
Image
String
String
LString
String

[»

-

Add Field
Field

Figure 23 Auto Create MDB

“‘“MDB Name” means that created MDB file name and you can change it.

“Table Name” means that created table name in MDB file and you can also

change it.

DB table structure will be created according to CSD file field structure.

@ Click Create button, DB will be created as setting. It will be connected with

CSD file’s fields automatically as below.



—_—
[, Connect Fields 3

Match CSD and DB Fields

C3D Fields DB Fields DB Fields

5 SMART_PRTMARK ~ PRTMARIC
6 SMART_PRTINFO PR
7 |PHOTO_CONFIG PHC
Da you want to connect Fields?

[ < BacklB] ][ Canfirm ] [ Cancel ]

Figure 24 Connect Fields

@ Click Yes, then CSD file fields and DB fields will be linked.

Click No, then fields will not be synchronized.

3.2.2.1 Create MDB
(O  Click Create MDB button, then “Input MDB Name” window will be displayed.

[Z. Input MDE Name 3

MDE Marme || \

Figure 25 Input MDB Name

@  Input MDB name and click OK button, “MDB Table Management” window will
displayed as Fig. 26.

[:. MDB Management £2

MDE Tahle Management

Mew Table

Edit Table

Remove Table

Connect Fields

o

Befresh
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Figure 26 MDB Table Management

Selected table structure of MDB file will be displayed on the left list and you

can create, edit and remove the table.

To create table, click New Table button.

[:. Mew Table

Table Name

- >
Fildhame Tye Length Create

Close

ool

Impart fram
D

Add Field

L€ €)L)€ €] €212

T}

Remave
- Field

Figure 27 Create New Table

Input a name in “Table name” section.

To input/edit the Field name, double-click to the empty Fieldname index or
data.

You can set the field type on Type column.

You can set the maximum data size of the field on Length column.

If you click Import from CSD button, table field will be set automatically

according to CSD file field structure as below.

[, New Table

E3
Table Name |001
Fieldrame Type Length I: Create
1 |NAME String 100
2 D String 100
3 |PHOTO mage [
4 POS String 100
5 PRTMARK String 2
6 PRTINFO Lstring N
7 |PHOTO_CONFIG String 255
Impart fram
CsD
Add Field
Remove
= Field

Figure 28 Create New Table — Import from CSD
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When you click Create button, a question message will pop up.

To create it, click OK.

3

[:. MDB Management

MOB Table Management
o] New Table
Edit Table
Remove Table
Connect Fields
Eiefresh

Figure 29 MDB Management

Figure 29 is created table.

@ To change selected table structure, click Edit Table button
To remove the selected table, click Remove Table button.

Click Connect Fields button, then you can connect the fields as Fig. 30.

['t-. Connect Fields 52|
Match CSD and DE Fields

8D Fields DB Fields DB Fields
1 EAHER A vE
2 3
> FEGTORNN 7010
+ S ~os
5 GMART_PRTMARK ~PRTMARK
6 |SMART_PRTINFQ  PRTINFO
7 PHOTO_CONFIG  PHOTO_CONFIG v

CAEARIAEARILS

Confirm

Figure 30 Connect Fields

3.3 Connect ODBC
To connect variety sorts of DBMS, SmartDB supports ODBC.
All databases supported by ODBC are available.
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(1 Click Database tab and Connect ODBC button. Then “Select ODBC Data

Source” window will be displayed as Fig. 31.

{7, Select ODBC Data Source £

Available Data Source
Card DataBase Source
Visual FoxPro Database ]
Visual FoxPro Tables
Select Table

Refiesh

II
E

Figure 31 Select ODBC Data Source
On the left side, you can see the data format which is available to connect.
If you click ODBC Manager button, then “ODBC Data Source Administrator” window

will be displayed as Fig. 32.

For more information, please refer to the related materials.

£ 0DBC Data Source Administrator BIx

User DN | System D5M | File DSM | Diivers | Tracing| Cornection Paaiing | Abaut |

User Data Sources:

Add
Card DataBa # Microsolt Access Driver [-mdb)

dBASE Files Microsoft dBaze Driver [ dbf) Remove

Excel Files Microsoft Excel Driver * xls)

M5 Access Database  Microsoft Access Driver " mdb) LCarfigure.

B A ODBC Uset data source sires infomation sbouk how 1o comeet o
(B the ndcated data provider. 4 User data sowrce is onl visble t you,
and can anly be used on the cument machine.

oK el ‘ ‘ Help ‘

Figure 32 ODBC Data Source Administrator

If you click Select Table button after select one source, you can see the different
window as per each source.

SMART Test data source is created from ODBC original administrator. Click Select
Table button, then “Available Tables and Views” window will be displayed and you can

select table or view.
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[%. Select ODBC Data Source 2

Available Tables and Views

oot

Connect Fields

[<Batk[ﬁ] ][ Nex(] » ] [ Close ]

Figure 33 Select ODBC Data Source

Click Connect Fields button after selecting a table, then Fig. 34 will be displayed.

[:. Connect Fields b

Match CSD and DE Fields

3D Fields DB Fields DB Fields

£l

1
2
3
4
5 SMART_PRTMARK

B SMART_PRTINFO
7 FHOTO_CONFIG

-

[ ¢Back®) | [ coiim | [ cConcel |

Figure 34 Connect Fields
CSD fields and DB fields can be connected.

While selecting MS Access Database, click Select Table button then you can select

MDB file as Fig. 35

Database Mame Directories:
C |
S =
002 mdb (= Program Files
& 184 System
[£= SmartDE [1Read Oniy
(= C5P
AR
o, 0
List Files of Type: Drives:
Acoess Databases (im v | [ B e | [ Hewer.. |

Figure 35 Select MDB

If select a MDB file and click OK button then table or window will be displayed.
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Thereafter it will run through same process as described before.

3.4 Save Project

Information of CSD file and Database connection will be saved in the project file
(*.csp). If it cannot be recorded, you need to proceed with many steps as above.

To avoid the inconvenience, if connection setting is finished, you need to save project

file.
To save project, click Save button in Home tab or File tab.

|
Open Save Print

Project Print

Figure 36 Save Project

3.5 Open Project

To open project, click Open button in Home tab or File tab.
When you import a file, CSD fields automatically will be connected database fields.

3.6 Input Data
To input data, click Add in Home tab or Database tab.

Input data in Value column.
Select an image after click “...” button when you use image field. To delete or change

an image, right-click Value column. When you select Select Image in context menu,

you can select new image. And also you can delete an image using Remove Image in

context menu.
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[:. Add Card 2
Narne Type Value E

1 [NAME String

2 ID String

3 PHOTO Image D

4 POS String

o PRMMARK swg

GRTNO lsws

o PHOTOCON Sy

Close

Figure 37 Add Data

If you click Capture button, you can use the images which are in USB Camera
connected to PC.

To save data and keep the current window, click Save & Close button.

To save data and close the current window, click Save & Continue button.

To clear whole data in current window, click Clear button.

To close the window without save, click Close button.

When input data, entered data will be printed as Fig. 38

Selected data is updated through data field and it is displayed in preview section.

Readirte|_CiprogramFies (:86)[DP S\ CSPlpanplganpleLnd>_ TABLE Ready ToalRecords: 5

Figure 38 View after Add Data

3.7 Edit Image

The image which is connected on Image fields can be modified. You can edit image

size and location easily using this function.
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Double-click a point of indicated field in preview screen on the right side, then “Image

Edit” window will be displayed. Or double-clicking image field on “CSD fields” on the

bottom will be the same.

When “Image Edit” window be displayed, the amount of changes is displayed as

percentage and values.
Blue dotted line on the center is the size of image field and the size is reduced

according to the size of “Image Edit” window. To modify the location of an image, you

can use left button of mouse by Drag and Drop.

r:. Image Edit

Set as Saved Set as Defalts

Apply Al Apply cancel

Figure 39 Image Editing Window

In “Image Edit” window, there are many simple and useful tools for editing images.

Brightness, Contrast, Zoom and Rotate functions are included from the top

|

wwwwwwwwwwwwwwwwwww

Figure 40 Edit Image Location

If brightness value is near to “0”, image will be darker.

If it is near to “100” image will be shown brighter.
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. Image Edit o ® 3 ., Image Edit o= %
Briiness 4 " > [ al Briness ¢ 0 >
Cantrast 4 0 DI Contrast ¢ [ » [ =)
Zoom [ Zoom ¢ ] > 100
Ratote > o Rotate 4|1 » o

o Porsat autofect ko Porrat Avotffect

Sot a5 Saved Sot 2 Defa setas saved Set a Defau

N
sy Al dosly Cancel senly 1 aesly Cencel

Figure 41 Edit Brightness

If contrast value is close to “0” then image will be more blur, on the contrary, if it is

close to “100” then the image will be shaper.

Zom < Mo om0 DI
Rota ¢ [ o) Rotate 41 > o
. po— m—
Apply Al Apply Cancel Apply Al Apply. Cancel
Figure 42 Edit Contrast
It is possible to resize an image by zoom function.
= S o ; >
Contrast 4 0 Ol Eal Contrast 4 ) >
2o0m 4 [ =] Zoom ¢ ] >
Rotats 4 il > \:| Rotate 41 » E
Apply Al Apply Cancel Apply Al Apply Cancel

Figure 43 Zoom in / Zoom out

Image can be rotated by 90, 180, 270, 360 degrees through Rotate function.
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B = I [2. Image Edit

0
0

i
5

mmmmmmm
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cccccccc

i
L

nnnnn

Figure 44 Image Rotation

0
(o)
5

2. Image Edit

aaaaaaaaaaaaa

8
1l

Figure 45 Auto Portrait / Auto Effect

To change brightness, contrast, zoom(minimize, maximize), rotator, move a scroll bar
or input value in edit box, and press Enter key.

You can input zoom value until second minority. (0.xx).

Auto Portrait is the function to find the face in the Image automatically.

Click Auto Portrait check box, then the image is focused on the face and adjusts the
size and position properly.

Auto Effect is the function to adjust the brightness and contrast in a picture

automatically. Click Auto Effect check box, then brightness and contrast is adjusted

properly.

To restore the default value, click Set as Saved button.

To turn back to the original CSD image file, click Set as Default button.

To save the changed setting value and close window, click Apply button.

To save and apply the changed setting value to all selected data and close window,
click Apply All button. It will be take some time depend on the data volume.

To close without saving changed setting value, Click Cancel button.

30



If click Apply or Apply All button, you can see modified image on preview.

@ [?)
W5 Add ﬁ (@ 53 Add ﬁ
= < Edit =2 < Edit
Position %3 Delete Edit Sosition %3 Delete Edit
Card Design Card Design

Front Side Front Side

enior Engineer

o

CSD Fields DE Fields CSD Fields DA Fields

Figure 46 Before Image Edit Figure 47 After Image Edit

When you modify the image, modified value will be set as Fig. 48.

=D Fields T DB Fields

D e’
01214

PHOTO

POS
Engineer

FRTMARI

FRTIMFO

PHOTO_COMFIG
0;0;0;24841:52,-99:-96;3;1 1

b’

Figure 48 Information of Edit Image

3.8 Select Data
You can select data to print or remove printer data. When you select data, all of the
lines will be selected. To select more data, you can click mouse left button and drag.
To select several data, press Ctrl Key and click lines. If a line has not selected, it will
be added from selected lines. And if a line has selected already, it will be excluded

from selected lines.
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25315

5 |y 0140

1201202
proTo

pos
Sales Wanager
PRTARK

PRTiNFO.

201302142143,

ReadWirte| _C:\Program Fies (+36)DP\Smart\CSP ganplellgampleLmdb_ TABLE. Ready TotalRecords 5

3.9 Print

(1 Select data to print edited cards.
@ Click Print button in File tab or Home tab.

r

[:. Select Printer

Figure 49 Select data

Printer

Mumhber of cards

IDP SMART-50 Card Printer [KYLE : USBO001]

Confirm

Cancel

Figure 50 Select Printer

3 You can see the printer lists which are connected to PC or Network — Fig. 50

The printers which have a word “USB” on the lists are connected to PC directly.

The printers which names start with IP address are connected to network.

Select a printer on the list, and click Confirm button.
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@ IDP SMART-S0 Card Printer [KYLE : USBO01] o Bl 22

W Lse Printer spool Remove prinked cards Reset Failed cards

NAME jis} PHOTO PO3 Z
1 John Dos 1201202 C:\Pragram Files (x86)\1DP Sales Managsr
2 Joe 106301 C:\Program Files (xB6)11DP Senior Engineer
3 Kyle 01215 :\Program Files (x86)\I0P\Engineer

<]
[4] | D]
Print. Close:
Ready Printed: 0/ 3

Figure 51 Print Standby
(® Figure 51 shows printer spooler window.
If there is several print data, you can click Use Printer Spool check box, so that
continually you can print several data to save time.

Click Print button, then all data on the lists will be printed.

&b IDF SMART-50 Card Frinter [KYLE : USBO01] o B =
7 |Use: Prinker spocl
WAME pisl PHOTO POS |Z|
1 John Dos 1201202 C:\Program Files (xB6J\DP Sales Manager
2 Jos 106301 Ci\Program Files (xBAJIDPY Seniar Engineer
3 Kyls 01215 C:\Program Files (xG6\IDPYEnginesr
4] D]
Stop Closs
Print is succeed Printed: 1/ 3

Figure 52 Screen at the printing.

The white background means the data which is ready to print. The green color
means under printing. After finish the printing, the color will be changed to yellow. If
there is an error during the printing, it will be changed to red color. Even though it

is under printing, you can add more data to print.

® If you click Stop button, it will stop all procedure after current printing data is done.
If you click Close button, it will close the window after current printing data is done.
SmartDB will stay “Standby” mode if there are the data which are spooling or
printing.
If you click Remove Printed Card button, Yellow color data that means printing is
done will be removed.

If you click Reset failed Card button, it will retry to print Red color data that means
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there was an error during printing.

@ When printing is done, click Close to return to main program.

Figure 53 Results

Printing results will be applied on data lists as Fig. 53.

3.10 Change Printed Data

Printed data cannot be printed again to prevent reissuance,

If you want to re-print, select the card and click &2 Unprinted button of Mark group
on Home tab.

On the contrary, if you don’t want to print unprinted data, select the card and click &
Printed button of Mark group on Home tab.

3.11 Use the Conditional Formula
If you want to display to specified data in the screen from lots of data, you can use
“Filter Bar”.

v b e Add
Apply

Fitter

Figure 54 Filter Bar

First section defines the connecting method of conditional option, if there are more

than two conditions, it will define the relations of two conditions.
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AND The earlier condition and new input
condition are satisfied both of them.
The earlier condition or new input condition

OR
is satisfied.

Second section is for selecting registered field name.
Third section defines to range of condition value.

= The data is equal to condition value

like The data is including to condition value

> The data is larger than condition value.

< The data is smaller than condition value
<> The data is different from condition value.

Fourth section is for inputting condition value.

If you click” Add” button, it changes set value to conditional formula and display next
line.

To create more than two “IF” formula , you can click “Add” button and after setting
second conditional formula you can click “Add” button again.

If you click “Apply” button, the results of searching will be displayed from database by

conditional formula.

For example, If you want to find data which includes “Der”, you can find it as Fig. 55.

Fiter g NAE v like | Doe aad
MNAME like %Doe%' Apply

Figure 55 Filterbar — Create Conditional formula
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4 Ribbon bar

4.1 Home tab

g B2 2 ey e % ey el B2

New Open Save Print Printed  Unprinted Al Printed  Unprinted | Printed Unprinted  Text  Posion | _ Edit
Cards Cards Cards % Delete

Project Print WMark Display Search Card Design

Figure 56 Home tab

The top of the program, at the bottom of the ribbon tab, ribbon bar is located.

4.1.1Project

4111 New |

This button closes existed project, and create new project.

|

41.1.2 Open —/

This button loads saved project file.

4.1.1.3 Save B

This button saves current project setting after create project.

4 .1.2Print

4.1.2.1 Print 4

This button prints selected data through card printer.

For more information, Please refer to Chapter 3.9

4.1.3Mark

e )
4.1.31 Printed **°

This button set selected data as print completed status.
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4.1.3.2 Unprinted Q‘g

This button set selected data as unprinted data so that you can print the data

again.

4.1.4Display

[
4.1.41 All Cards %*

This button shows all of the data of connected database.

4.1.4.2 Printed Card >

This button shows all printed data of connected database.

4.1.4.3 Unprinted Cards

This button show unprinted data of connected database.

4 .1.5S8earch

fﬁ\"‘
4151 Printed *

This button finds next printed card

4.1.5.2 Unprinted @

This button finds next unprinted card

41.53 Text =%

This button finds cards which have specified string.

If you click the button, the dialog box will be displayed as Fig. 57
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[:. Find Next Matched Card 23

String

Figure 57 find matched card

To find specified data, click Find button after filling text box.

=

. e
4.1.5.4 Position ™

This button finds the data which is on specified position.

If you click the button, the dialog box will be displayed as Fig. 58

[, Find Mext Directed Position 23

Position ‘

Figure 58 Find Position

To find specified position, click Find button after filling data position.

4.1.6Card

P
4164 Add @

This button adds new data. Please refer to Chapter 2.3.

4.1.6.2 Edit ©

This button edits selected data. Please refer to Chapter 2.4.
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-, Update Card =

Narne Type
1 [NAME String John Doe

2 1D String 1201202

™y
3 PHOTO Image q

4 POS Siring _ Sales Manager

HER ()

Figure 59 Editing Data

TN

4.1.6.3 Delete @

This button deletes the selected cards. If you removed data once, it could not

be recovered. So please be careful to use this button.

4.1.7 Design
4.1.7.1 Edit

This button executes SmartDesign program to modify the used CSD file in the

program.

4.2 File tab

4.2.1New

After close existed project, create new project from designed CSD file.

4.2.2 Save

Save current project setting.

4.2.30pen

After close existed project, load the saved project file.

4.2 4Close

Close the opened project.

4.2.5Print
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4.2.5.1 Print

Print a selected card. Please refer to Chapter 3.9

4.2.5.2 Save Preview as BMP file

Save preview as BMP file. You can select the side to save.

4.2.6 DataBase
4.2.6.1 Import data from ODBC

Through ODBC, you can input data from the other DB

When execute menu, the window like Fig. 60 “Select ODBC Data
source” will be displayed.

[2. Select ODBC Data Source

Available Data Source

Card DataBase Source

ODBC M.
Visual FoxPro Database = anager

Visual FoxPro Tables

Refresh

Figure 60 Select ODBC Data Source

To select data source, click Confirm button.

£, Import from ODBC

Table [ sample -

DA Figlis Type ODBC Fields ODBC Fields
1 [ramE String
2 D

3 PHOTO
4 POS

John Doe

D
1201202

v
v
v
v
: PRINFO ey OO
7OPHOTOCONFIG | swng

POS
Sales Manager
PRTMARK

NAME D | PHOTO FOS | PRTMARK | FRTINFO | Image

Figure 61 Import from ODBC



Structure of selected data source on the left of screen is displayed.
Connect ODBC field item to DB field.

If the connecting is done, click Import button.

4.2.6.2 Import Excel

Import excel file and you can modify data.

B Microsoft Excel - Book1.xIs

@_] Elle Edt Wiew Insert Format  Tools  Data  MWindow

EHROSIE B9 8

c7 - 3
p | 8 [ e ] o | E |

1 |Mame Mo Position  Picture
2 |Stephano | 101011 Vice President
3 |Gorzales 101012 Oversea 5ciiksj jpg
4 |Burlock 101013 Director
5 |Newton 101014 CTO
§ Murdode | 101015 CFO
-
- "

Figure 62 Contents of Excel File

Fig. 62 is the example of excel file.
Click Import data from Excel button and select excel file.

“Import from Excel” window will appear.

I', Import from Excel

Sheet | sheett -

I¥ There is title on the first line

DB Fields
IAME

D

PHOTO

4 P08

E =

5 OPRTMARK  sling
5OPRTNFO uswng
FoOPHOTOCONFIG — swmg

Type

String
String
Image
String

Excel Fields

quuu

Excel Fields

o
1201202
PHOTO

FISMamCSPeampletisamplet - Im:
POS
Sales Wanager

NAME D PHOTO POS
1 [ohnDoe 1201202 Jsamplel - ImagelPHOTO_(Sales Manager

Figure 63 Import from Excel

You can check the bottom of screen and there will be descriptions of
analyzed contents of excel file.
First line is field name. In fact, data will be imported from second line.

The field name and selected data from be

list of bottom will
displayed on the right side of screen.

On the left side of screen, you can check DB field name and you can



select excel file in “Excel fields” topic on the right side.

To Connect DB fields and excel fields, click Import button.

N Smart DB o B o2
Ol fore  Dabmse  optons  Hep 1)
~ = = @ @ @
E > A 3 | = @ @ @ add 4
L = 4 S & | ¥ > BB B . =
S ¥
New  Open  save Prnt | printed Umprited | Al | Prnted Unprinted | Printed Unprited  Text  Positon et
Cards | Cards  Carcs 53 Delete
Project print werk Dspiay Search card Design
v NAME ke v Add
Fiter Doe
Aol
T ) T
o8 e | D | oo [ ees
)
1 |dohn Doe 12m22 Pl soes vencger
) 1201202
2 |we 108301 Pl senior Engineer
- John Doe
r» {
3 |k o215 Tl e
CSD Fieks DB Fields
) FAWE ~
4 ki 25315 5l procuctenager [John Doe
[
r 1201202
5 |y ea0140 Manager FHoTo
pos
PRTMARK
PRTINFO
v
ReadMirte| C:\Program Fies (x36) P Smart|CSP sample gampleLmdb_ TABLE Ready Total Records : 6

Figure 64 after import from Excel

4.2.6.3 Export data to ODBC

Save opened project data in MDB file.

I', Export to MDB 2
Total Records : 6 Table Name | sample
DB Fields Type MDB Fields DB Fields
1 [ramE String  NAME
2 ID String 1D John Doe
3 PHOTO Image  PHOTO B
4 POS String | POS 1201202
5 PRTMARK String  PRTMARK
6 PRTINFO Lsting  PRTINFO FHOTO
7 PHOTO_CONFIG Sffing  PHOTO_CONFIG E
POS
Sales Manager
PRTMARK
NAME D PHOTO POS PRTMARK PRTINFO PHOTO_
1 [ohnDoe J1201202 Sales Manager 2013021 47143;2013021422
2 Joe 106301 Senior Engineer * 2013021 42220
3 Kyle 01215 Engineer - 0,0,0;24841;52;
4 Kim 235315 Product Manager
5 Joy 630140 Manager
6 JohnDoe 1201202
o I |

Figure 65 Export to MDB

All of data fields and data in the project will be displayed at the
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bottom of the screen and selected data from list will be displayed
with field name on the upper right.

DB field name and created MDB field name will be displayed on the
upper left.

If you double-click “MDB Fields”, you can modify contents.

Image data will be saved to MDB from the OLE object type.

The number of all data will be shown on the upper screen. All fields
will be created.

“Table” sets the name of created table on MDB. Basically current
project name is determined.

Click Export button, and specify location of MDB file and name. If

you specify MDB file name, project data will be recorded immediately.

4.2.6.4 Export data to Excel

You can save the current project data using this function.

[X. Export to Excel x4

Total Records : 6 I™ Estra Fields Image Folder ‘ samplel - Image

DH Fields Type Excel Fields DB Fields
1 String  NAME
2 D Siring 1D John Doe
3 |PHOTO Image  PHOTO D
1 [POS Sting  FOS 1201202
]
6
7

PRTNFO  Lswng  [THOT

POS
Sales Manager

PRTMARIK

NAME ID PHOTO PO3 PRTMARK PRTINFO PHOTO_
1 [ohnDoe J1201202 Sales Manager 201302142143,2013021422
2 Joe 106301 Senior Engineer |+ 201302142220,
3 Kyle 01215 Engineer - 0;0,0;24841:52;
4 Kim 235315 Product Manager
5 oy 630140 Manager
[} John Doe (1201202
il [— |

Figure 66 Export to Excel

All of data fields and data from project will be shown at the bottom of
the screen. You can check selected data on the upper right of the
screen. Also you can check DB field name and field name in excel
file on the upper left side. If you double-click “Excel Fields”, you can

edit contents.
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“Total records” and “Extra Fields” will be shown on the upper screen.
When “Extra Fields” is activated, hided fields (print results field, print
history field, image field, modify history field) will be recorded in an
excel file.

“Image directory” column defines the directory which is recorded
image file in. It will create the specified excel file name which is
saved to sub-directory.

If you click Export button, it will set the location and name of
exported excel file. If you set an excel file name, project data will be

record in an excel file.

4.2.7 Print History
Data print history from opened project data will be shown. When execute

menu, “Log file select” window will pop up. Print history is recorded by
monthly. When you select a file in specified month, print history appears

as Fig. 67

B Print-201007.log - Notepad
File Edt Format View Help

2010.07.20 01:42:02 SMART PRINTED (Michael, 101024, President)

2010.07.20 01:43:05 SMART PEINTED (Derek, 101036, President)

2010.07.20 01:44:08 SMART PRINTED (Steve, 101020, Sales Manager)

2010.07.20 02:01:53  SMART CARDIN FAIL There 1s no card on the hopper (code=8000000B) (Charlie, 101039, Sales Manager)

Figure 67 Print History

Print history will be recorded print time, date, used printer ID, results of
printer, and simple information of error, error code and information of

used data.
4.2.8 Exit

Exit the program. If you change the structure of project to exit the

program, you have to save before you exit the program.
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4.3 Database Tap
4.3.1 Connection
4.3.1.1 Connect MDB

You can connect MDB file. Please refer to Chapter 3.2.2

4.3.1.2 Connect ODBC
You can connect database through ODBC.

Please refer to Chapter 3.3

4.3.1.3 Disconnect
This function is to disconnect database.

If the database is disconnected, data and information will be disappeared.

4.3.2 Setting
4.3.2.1 Field Setting
When it is connected to database, a connection is composed between CSD
field and database.
DB field which connects with CSD field appears on the left side and you can
change DB field, on the right side, also you can check data in current DB
Fields.

I, Connect Fields 53

Match CSD and DE Fields

G50 Fields DB Fields DB

1 [HEHENS| A HE NAME -
2

0] John Doe
3 [FHOTONMNNN F-oTo

hd

hd

ad )
4 POS v

v

hd

hd

1201202
5 |SMART_PRTMARK  PRTMARK

§ |SMART_PRTINFO  PRTINFO IO
7 |PHOTO_CONFIG  PHOTO_CONFIG

POS
Sales Manager

PRTMARK

Figure 68 Set field Connecting
4.3.2.2 Compress and Restore

If connected database type is MDB, you can use this function. MDB charges

inefficient space more than needed. As time goes by, space for MDB is
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increased more and more. At that time, “Compact and Recovery” function is

able to use and through this function useless space can be removed.

4.3.3DB Security
4.3.3.1 Password
You can set a password in MDB of project.
Click Password button, “Password Configuration” window is displayed.
Click OK button after input the same password that you want in the “New

Password” and “Confirm Password”, then password is set.

If you open the project locked by password, “Input Password” window is

displayed. Input Password and click OK button to open the project.

Password Configuration 3

Old Password
New Password

Confirm Password

[~ Remove Password

Figure 69 Set Password

[7. Input Password 23

This DB is protected by password,

Please enter the passwaord in the box,

Password

(o] [ome]

Figure 70 Input Password

4.3.4Card
4.3.41 Add

This button adds new data. Please refer to Chapter 2.3.
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-, Update Card =

Narne Type
1 [NAME String John Doe

2 1D String 1201202

%
3 PHOTO Image ]

4 POS Siring _ Sales Manager

Figure 71 Add Card

4.3.4.2 Edit

This button edits selected data. Please refer to Chapter 2.4.

-, Update Card =

Narne Type
1 [NAME String John Doe

2 1D String 1201202

»,
3 PHOTO Image ]
4 POS Siring _ Sales Manager
5 PRIMARK  Sting
& PRTNFO  LString ]
7 PHOTO_CON. String -

Figure 72 Edit Card

4.3.4.3 Delete
This button deletes the selected cards. If you removed data once, it could not

be recovered. So please be careful to use this button.

4.4 Options tab
4.4.1Language

Select the preferred language.

4.4.2Plugins

Select Plugin lists and Plugin you are going to use.

Please refer to Appendix.1

4.4.2.1 Image Capture
The plugins those are available to capture images are displayed as low level

of menu and you can select plugins for “Add” and “Edit”.



Image Contact Contactless
Capture - Card~ Card~

v | Capture Plugin Sample

Test Capture Fr

T

Figure 73 Select Capture Plugins

4.4.2.2 Contact Card
The plugins those are available to encode contact card are displayed as low

level of menu and you can select plugins for “Add” and “Edit”.

If you select plugin and click, “Set Contact Card Encoding” window is

displayed.

To use contact card encoding, click Use Contact Card Plugin Encoding
check box. Click Encoding check box in field to encode.

If you click Setup button, “Contact_Plugin_Sample.ini” file is open.

You can configure options of contact card encoding field. Now only sample is
provided in contact card encoding, so field is empty. For further information,

please refer to Appendix.1

» i 3
|: \'g}

Image Contact Contactless
Capture = Card - Card~

v | Contact_Plugin_Sample

Figure 74 Select Contact Plugins
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[*. Set Contact Card Encoding £

Srnart Card Encoding

[P U5 Cantact Tard Fliain Endoding

Select Field

Please select the filed type and check the field
FieldMame Type Encoding

1 [FHOTC ] RawData » [
2 |NAME Sting | [
3 |DEPT Sting v [
4 |VALID Sting | [
5 |ADD1 Sting  »| [
6 |ADDZ Sting % [
7 _|PHNO Sting % [
8 |DOB Sting % [
3 |BG Sting % [
Setup Ok Cancel

Figure 75 Contact Plugins Option

P Contact_Plugin_Sample.ini

[ This is IC Plugin Sample IMI
Please modyfy the structure and option values to be used in your plugin dil

[Information]
Plugln=IC_Plugin_Sample ini
CardType=Not Defined
[Field1]

[Field2]

[Field3]

Figure 76 Contact Plugins INI Setup
4.4.2.3 Contactless Card
The plugins those are available to encode contactless card are displayed as

low level of menu and you can select plugins for “Add” and “Edit”.

If you select plugin and click, “Set Contactless Card Encoding” window is

displayed.
To use contactless card encoding, click Use Contactless Card Plugin
Encoding check box. Click Encoding check box in field to encode.

If you click Setup button, “Contactless_Plugin_Mifare1k.ini” file is open.

You can configure options of contactless card encoding field. Now only Mifare
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1K is provided in contactless card encoding. For further information, please

refer to Appendix.1

3 k>
F | @

Image Contact Contactless
Capture = Card = Card =

Flugin V| Contactless_Plugin_MifarelK

Figure 77 Select Contactless Plugins

*. Set Contactless Card Encoding 3

Smart Card Encoding

Use Contactless Card Plugin Encoding

Select Field
Please select the filed type and check the field

FieldName Type Encoding
1 [FHOTO ] RawData ~ [
2 [NAME Sting % [
3 |DEPT Sting | [
4 |VALID Sting | [
5 |ADD1 Sting | [
6 |ADD2 Sting & [
7 |PHNO String R ]
g |DOB Sting | [
5 |BG String e (|

[ ] [ =]

Figure 78 Contactless Plugins Option

P Contactless_Plugin_Mifarelk.ini

-Contactless Plugin INI for Mifare 1k
-Please modify the structure and the option values to be used in your plugin.dll

[Information]
Plugin=RF_Plugin_Mifare1k.dll
CardType=Mifare 1k

[Field1]

Figld=NAME

Area=hlock25 0-block 25 15
KeyAB=A

Key=FF FF FF FF FF FF

Figure 79 Contactless Plugins INI Setup
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4.5 Help tab
4.5.1 Manual
4.5.1.1 Manual

This SmartDB user manual will be open.

4.5.2 About
4.5.2.1 About

Introduce program version, information etc.

Smart DB Information &3

SmartDB Version 1.0 {130213)
Copyright (C) 2008-2013

S

Figure 80 SmartDB Information
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APPENDIX

Plugin

Other functions besides basic functions in SmartDB are supported as Plugin type.

If you make a file according to SmartDB plugin regulation, the plugin can be used in
SmartDB.

1.1 Plugin Registration

You can use any name for plugin file but the extension type should be “.dIl”
If you copy plugin files in “plugin” folder where SmartDB is installed in, and restart

SmartDB, you can use the plugin in SmartDB program.

If there is no plugin in “plugin” folder, plugin buttons are inactivated.

Plugin

Figure 81 No plugin.dil

After copying plugin files like Figure 75 and restart SmartDB, the plugins are registered
automatically and plugin buttons are activated.

Eile Edit View Favaorites Tools  Help o

OBack M > | 'ﬁ' /-“Search W= Fn\ders| Elv

address |[3) Ci\Program Files\ e SystemiSmartiplogin v| e

Folders e Plugin_Sample_01.dl Plugin_sample_0z.dl
Documents and Settings ~ "’.h« 1.0.01 "'h,‘ 1.0.0.1
= = W TODO! <File description> W TODO: <File description>
1) driverck

I55) Metapace Printer Driver

Figure 82 Copy of Plugins
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Image Contact Contactless
Capture = Card~ Card -

%t\\

v | Capture Plugin Sample

Test Capture Fr

¥ EEETTT

Figure 83 Plugin Auto-Registration

1.2 Plugin Development
You can develop plugins as “DLL” type.

There are some regulations for developing plugin and you must follow the regulations.

1.2.1 Plugin Functions

Plugin must include below functions.

int WINAPI GetPluginInfo(SPI_INFO * pInfo)
int WINAPI StartPlugin(HANDLE hDone, SPI_VDATA* pInput, int nSize)

int WINAPI EndPlugin(SPI_VDATA* pOutput, int nSize)

The below is the explanation of each function.

® GetPlugininfo()

This function gets plugin information.

int WINAPI GetPluginInfo(SPI_INFO * pInfo)

Imports plugin information

Parameter * pInfo
Structure pointer for the information of plugin.

Please see the explanation of SPI_INFO below.

Return 0 : Success

Others : Fail

® StartPlugin()

This function begins plugin action.
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int WINAPI StartPlugin(HANDLE hDone, SPI_VDATA* pInput, int

nSize)

Begins plugin action.

Parameter hDone
An event handler for alarming to SmartDB after image
capture is done.
If bUseEvent of SPI_INFO is false, hDone will be NULL and
there is no event after capture is done.
But all the capture process should be done in SPI_Start
function.
If bUseEvent of SPI_INFO is true and Plugin action is done,
you should generate an event using hDone handle.

generate an event like below code.

::SetEvent ( hDone );

If calling EndPlugin(), this function is finished though Plugin
action is in progress.

*pInput

A pointer of data to get from SmartDB

nSize

Size of structure of SPI_VDATA to get from SmartDB

Return 0 : Success

Others : Fail

® EndPlugin()

This function finishes plugin action.

int WINAPI EndPlugin(SPI_VDATA* pOutput, int nSize)

Finishes plugin action.

Please end plugin process in this function.

Parameter *pOutput
A pointer of SPI_VDATA to send to SmartDB when plugin

action is finished.
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nSize

Size of structure of SPI_VDATA to send to SmartDB

Return 0 : Success

Others : Fail

1.2.2 Plugin Structure

@ SPI_INFO

This structure shows the information of plugin.

typedef struct

{
WCHAR szName[64]; // The name of plugin
WCHAR szDesc[256]; // The description of plugin
int nClassld; // Class information of plugin

BOOL bUseEvent; // Check if event handle use or not

int nTimeOut; // Timeout of plugin
BYTE reserved[56];
} SPI_INFO;

Shows the information of plugin

szName is plugin’s name. Please be careful of overlapping between this
and other names.
2 Byte Wide String (Unicode), MAX size is 64 characters including
NULL.

szDesc is the brief information of plugin.
2 Byte Wide String (Unicode), MAX size is 256 characters including
NULL.

nClassid means class-code which plugin belongs to.
#define SPI_CLASS_UNKNOWN OXFFFFFFFF
#define SPI_CLASS_IMAGEACQUISITION 0x00000001

55



#define SPI_CLASS_CONTACT_CARD 0x00000010
#define SPI_CLASS_CONTACTLESS_CARD 0x00000100

SPI_CLASS_IMAGEACQUISITION is the class code of plugins to get
image from camera, sign-pad and etc. SPI_CLASS_CONTACT_CARD,
_CONTACTLESS_CARD are the class code of plugins to encode contact

card or contactless card with PC/SC protocol.

bUseEvent sets whether event handler to alarm that plugin action is done
is used or not. If the value is TRUE, StartPlugin() can get event
handler. If it is FALSE, plugin action should be done in StartPlugin

function.

nTimeOut finishes plugin action by calling EndPlugin() when it receives no
response during the setting time after calling StartPlugin(). If
bUseEvent is FALSE, input this value 0. If it is TRUE, input this value in

seconds.

reserved is not available now. Fill it with 0.

® SPI_VDATA

SPI_VDATA is the variable size structure that plugin function and
SmartDB sends and gets. The input/output data of this structure
depends on the class of plugin.

Please see the explanation of class of plugin below.

typedef struct
{
int nVersion; // Version of SPI_VDATA
int nTotalSize; // Total size of structure includes header and data
int nFields; // number of fields
SPI_VDATA_VFIELD field[nFields];
} SPI_VDATA;

the variable size structure that plugin function
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nVersion is the version of SPI_VDATA. Now version is 1.

nTotalSize is the total size of structure includes header and data. Be

careful because it depends on size of SPI_VDATA_VFIELD.

nFields means the number of fields. It depends on the input/output state
of nClassID of plugin. SPI_VDATA_VFIELD is defined variably

according to nFields value.

field[nFields] is the SPI_VDATA_VFIELD structure of field information.

Please see the explanation of structure below.

typedef struct
{
WCHAR szName[32]; // Name of Field
int nType; // Type of Field
int nSize; // size of Field
BYTE value[nSize]; // Field Data to input

)} SPI_VDATA_VFIELD;

the variable size structure of field information declared in SPI_VDATA.
szName is the name of field.
2 Byte Wide String (Unicode), MAX size is 32 characters including

NULL.

nType is defined by data type depends on field value.

#define  SPI_FIELD_DATATYPE_INT 1 // Integer
#define SPI_FIELD_DATATYPE_STRING 2 // 2Byte Wide String
#define  SPI_FIELD_DATATYPE_RAW 3 // Raw data

nSize is the size of field (Byte). It is depends on field type.

nType nSize
SPI_FIELD_DATATYPE_INT 4
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SPI_FIELD_DATATYPE_STRING

Size of string including

2Byte NULL

SPI_FIELD_DATATYPE_RAW

Size of Raw data

value is data of field. If nType is SPI_FIELD_DATATYPE_STRING, 2Byte
Wide String (Unicode) including NULL.

1.2.3 Plugin Class

There are 3 plugin classes which are SPI_CLASS_IMAGEACQUISITION,
SPI_CLASS_CONTACT_CARD

now. More classess will be added in the future.

and SPI_CLASS_CONTACTLESS_CARD

The variable structure SPI_VDATA depends on Class type.

@® SPI_CLASS_IMAGEACQUISITION

If nClassld is SPI_CLASS_IMAGEACQUISITION, the pointer *pInput

and *pOutput is defined as below.

[*pInput]

There is no field data to get from SmartDB in SPI_CLASS_IMAGE
ACQUISITION. The value is NULL in StartPlugin() function.

[*pOutput]

EndPlugin() function send the path of captured image to SmartDB.

You should input the path and data of captured image in *pOutput.

SPI_VDATA *pOutput

nVersion 1

nTotalSize Total size of SPI_DATA

nFields 1

field[0] szName L"ImageCap”
nType SPI_FIELD_DATATYPE_STRING
nSize Size of value including NULL
value Path of captured image + (NULL)

Input 1 which is SPI_VDATA version
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{

Input the total size of SPI_DATA including version information.

Input 1 in nFields because the path of captured image is used as
one field.

Input Wide String L"ImageCap” including NULL in field[0].szName.

Input SPI_FIELD_DATATYPE_STRING in field[0].nType because the path
of captured image is string type.

Input the size of value including NULL(2Byte).

Input the path of captured image in field[0].value.

Then it can send the data about captured image to SmartDB by
*pOutput pointer.

For example, if the path of captured image is “C:\image.bmp”,
SPI_VDATA *pOutput is as below.

SPI_VDATA *pOutput

nVersion 1

nTotalSize 110

nFields 1

field[0] szName L"ImageCap”
nType SPI_FIELD_DATATYPE_STRING
nSize 26
value L"C:\\image.bmp”

The Pseudo code of plugin with SPI_CLASS_IMAGEACQUISITION is

as below.

[Pseudocode]
nt WINAPI GetPluginInfo(SPI_INFO* plInfo)

//Input the information of Plugin
plnfo->szName = L” Capture plugin” ;
pinfo->nClassid = SPI_CLASS_IMAGEACQUISITION;
0;

plnfo->bUseEvent = false;

pInfo->nTimeOut

return nres,
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int WINAPI StartPlugin(HANDLE evtDone, SPI_VDATA* plnput, int nSize)

{
//Capture Image and Save the path of image
GetCapturelmage();
SaveImagePath() ;
return nres;
}

int WINAPI EndPlugin(SPI_VDATA* pOutput, int nSize)

memcpy (pOutput->field[0].value, szImgPath, pOutput->field[0].nSize);

{
//Stop Thread in progress and Return the path of image
pOutput->nVersion = 1;
pOutput->nField = 1;
wescpy (pOutput—>field[0].szName[0], szlmageName);
pOutput—>field[0].nType = SPI_FIELD_DATATYPE_STRING;
pOutput—>field[0].nSize = wcslen(szImagePath) + 2;
pOutput->nTotalSize = 12 + 72 + pOutput—>field[0].nSize;
return nres;

}

® SPI_CLASS_CONTACT_CARD,
SPI_CLASS_CONTACTLESS_CARD

If nClassld is SPI_CLASS_CONTACT_CARD / SPI_CLASS_CONT

ACTLESS_CARD, the pointer *pInput and *pOutput is defined as below.

[*pInput]
You can get the data about Smart Card encoding in SmartDB through
*pInput.

SPI_VDATA *pInput

nVersion 1

nTotalSize Total size of SPI_VDATA
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nFields 1+k
field[O] szName Name of Smart Card Reader
nType SPI_FIELD_DATATYPE_RAW
nSize 4
value Function Pointer of Transmit() function
field[1] szName Name of 1st Field
nType Type of 1st Field
nSize Size of 1st Field
value Data of 1st Field
field[2] 2nd Field
field[3] 3rd Field
filed[k] kth Field

Input 1 which is SPI_VDATA version now in nVersion.

Input the total size of SPI_DATA including version information.

Input the name of Smart Card Reader and Function pointer of

Transmit() function (4Byte) in 1 Field.

If nClassId is SPI_CLASS_CONTACT_CARD, function pointer should be
indicated SmartComm_ICTransmit() function of SDK. If nClassld is

SPI_CLASS_CONTACTLESS_CARD, function pointer should
indicated SmartComm_RFTransmit() function of SDK.

For example, this function pointer is used like below code.

//Definition
typedef int (*PFN)(int , DWORD , BYTE* , DWORDx , BYTE* );

//Usage in the function

PFN Transmi tAPDU;

TransmitAPDU = *(PFNx) (theApp.pVData->field[0].value);
TransmitAPDU ( DEV_INTERNALRF, nlencmd, btCmd, dwlenrcv, btRcv);

For further information, please refer to Smart SDK manual.
And refer to source code in this plugin in “*Program Files\IDP\Smart

\PluginSample” after SmartDB installation.
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The field data to get from SmartDB begins field[1].

Input the name of 1 field in field[1].szName.

Input the type of 1% field in field[1].nType.

Input the size of 1 field in field[1].nSize.

Input the field data to get from SmartDB in field[1].value.

If there are more than 2 fields from SmartDB, 2™ field data is
entered in field[2]. In this way, k numbers of fields are entered and

send to plugin function through *pInput pointer.

For example, consider that you do Contactless Card Encoding.
nClassld is SPI_CLASS_CONTACTLESS_CARD, Smart Card Reader is
“OMNIKEY CardMan 5X21-CL 0%, the number of the field to get from
SmartDB is 1, name of field is "Name” and value is “John”.
SPI_VDATA is as below.

SPI_VDATA *pInput

nVersion 1

nTotalSize 170

nFields 2

field[0] szName L"OMNIKEY CardMan 5X21-CL 0”
nType SPI_FIELD_DATATYPE_RAWDATA
nSize 4
value 4bytes Function pointer

field[1] szName “Name”
nType SPI_FIELD_DATATYPE_STRING
nSize 10
value “John”

[*pOutput]

There is no field data to send to SmartDB in Contact/Contactless card

encoding. The value is NULL in EndPlugin() function.

The Pseudo code of plugin with SPI_CLASS_CONTACT_CARD,
SPI_CLASS CONTACTLESS_CARD is as below.
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[Pseudocode]
typedef int (*PFN)(int , DNORD , BYTEx , DWORD* , BYTEx );

int WINAPI GetPlugininfo(SPI_INFO* plInfo)

{
//input the information of Plugin
plnfo->szName = L” Plugin Smart Card” ;
pinfo->nClassid = SPI_CLASS_CONTACTLESS_CARD;
pinfo->nTimeOut = 0;
plnfo->bUseEvent = false;
return nres;

}

int WINAP| StartPlugin(HANDLE evtDone, SPI_VDATA* plinput, int nSize)
{
//Read the field information from SmartDB and INI information
ReadSetupFile();
//Get the Function Pointer of Transmit()
PFN Transmi tAPDU;
TransmitAPDU = *(PFN«x)( plnput->field[0].value);

//Authentification and ReadWrite

BYTE comdbuf[] = L".............”",; // Define APDU Command

Transmi tAPDU(DEV _INTERNALRF, nlencmd, comdbuf, awlenrcv, btRcv);
// Repeat Transmit APDU to read/write smart card

return nres;

}

int WINAPI EndPlugin(SPI_VDATA* pOutput, int nSize)

{
//Stop Thread in progress and quit plugin
TerminateCapThread();
return nres;

}
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1.3 Usage of RF_ Plugin_Mifare1k.dll

SmartDB provides plugin DLL of SPI_CLASS_CONTACTLESS_CARD for encoding
Mifare1K of contactless card encoding. Please set the fields to encode in SmartDB

and input the information of encoding Mifare.

1.3.1 SmartDB Configuraion
Click Contactless card button in Option tab, select Contactless
_Plugin_Mifarelk.

=
(2] F | @

Image Contact Contactless
Capture = Card - Card
Plugin | [/ | Contactless_Plugin_Mifarelk

Figure 84 Plugin Selection

Then “Set Contactless Card Encoding” window is displayed.

[, Set Contactless Card Encoding 22

Smart Card Encoding

Usze Contactiess Card Plugin Encoding

Select Field
Please select the filed type and check the field

FieldName Type
1 |[NAME String
2 |ID String
3 |PHOTO RawData
4 |POS String

i

QR
COOEEE

=
&

Setup 0K Cancel

Figure 85 Set Plugin option

To use contactless card encoding, click Use Contactless Card Plugin Encoding

check box. Click Encoding check box in field to encode.

In above Figure, NAME and ID fields are checked, so *plnput data of SPI_VDATA

is as below.

SPI_VDATA *pInput
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nVersion 1
nTotalSize 256
nFields 3
field[O] szName L"OMNIKEY CardMan 5X21-CL 0”
nType SPI_FIELD_DATATYPE_RAWDATA
nSize 4
value 4bytes Function pointer
field[1] szName “NAME”
nType SPI_FIELD_DATATYPE_STRING
nSize 10
value “John”
field[2] szName “ID”
nType SPI_FIELD_DATATYPE_STRING
nSize 14
value L"201302"

1.3.2 INI File Configuration

Next, edit INI file to set the configuration to encode Mifare card.

If you click Setup button, “Contactless_Plugin_Mifare1k.ini” file is open.

P Contactless_Plugin_Mifarelk.ini -

Contactless Plugin INI for Mifare 1k

[Information]
Plugih=RF_Plugin_Mifare 1k dil
CardType=Mifare 1k

[Field1]
Field=NAME
Area=block25 0-block25 15
KeyAB=A

Key=FF FF FF FF FF FF

ODEHE) HIE MA@ 20 =S2H)

Flease modify the structure and the option values to be used in your plugin di

Figure 86 INI Plugin Configuration




Basically, Contactless Plugin_Mifare1k.ini file is defined as below.

Contactless_Plugin_MifarelK.ini

[Information]
PlugIn=RF_Plugin_Mifareik.dll
CardType=Mifarelk

[Field1]

Field=NAME
Area=block25.0-block25.15
KeyAB=A

Key=FF FF FF FF FF FF

Configuration value for encoding in DLL. You can edit it for your purposes.

[Information] is the information of plugin.
PlugIn means the dll file to use this ini file.

CardType is the type of card to encode.

[Field#] is the paragraph to define the information of field to encoding.
You can make it as many fields as encoding.

Field should be entered as the name of field to get from SmartDB. For
example, if Field=NAME is defined, DLL file matches the string
“NAME” in INI file with the string "NAME” to get from SmartDB,
field[i].szName, then use the same data to encode.

Area is the information of position to encode in Smart Card. In this case,
it is defined by block on Mifarelk DLL. “block25.0-block25.15” means
that encoded block is 25" block and it encodes from 0™ Byte to 15
Byte of 25" block. You can define “block25” instead. It is analyzed by
RF_Plugin_Mifarelk.dll. Also if it needs several block to encode, you
can use more block like “block25-block26”.

This RF_Plugin_Mifarelk.dll is for MifarelK card to encode only.
Mifare1K don’t allow encoding in 0™ block and every 4™ block (3, 7,
11, 15...). If user sets “Area=block3”, it encodes next block (4%
block) automatically because RF_Plugin_Mifarelk.dll analyzes the

syntax.
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KeyAB defines Key Side whether to use A of Key or B of Key.
Key means the value of Key to load Key Side defined KeyAB. 6 Byte, Hex
String.

1.3.3 Data Encoding
In this sample Contactless_Plugin_Mifare1K.INI in 1.3.2 and predefined *plnput
of SPI_VDATA in 1.3.1, only 1 field will be encoded because only [Field1]
section is defined in INI file. DLL encodes “John”, the data of field[1].value of
*plnput to match “Field=NAME” with. Area is defined from 0" Byte to 15" Byte
of 25 block.

block25 (0|1 |2 (3|4 |56 |7 (8|9 |1 |11 |12 |13 |14 | 15
Data J o) h n

In above table, the size of real encoded data is 10 Bytes because it is Unicode
and includes NULL. It is encoded from 0™ Byte to 9 Byte of 25 block.
However user defined Area to 15™ Byte, NULL is filled from 10" Byte to 15
Byte.

And data of field[2] in *plnput of SPI_VDATA is not encoded because only

[Field1] section is defined in INI file.

Refer to source code in “Program Files\IDP\Smart\Plugin” folder after SmartDB

installation.
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